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Overview

General
The Micro Greyline operator interfaces (OI) offer cost effective solutions to industrial control
designs requiring the use of a “man-machine interface” between the system and an operator.
These rugged terminals interface to a wide variety of programmable logic controllers or
industrial PCs and offer features that are typically found only on more expensive products.
The 1024 and 524 offer a 2 line by 20 character LED backlit liquid crystal display for the
most cost-sensitive applications, while the 1025 and 525 offers a 2 line by 20 character
vacuum fluorescent display for better visibility in any environment.
Up to 200 screens of information may be programmed into each Micro Greyline operator
interface.  Each screen may be configured as a message screen, menu screen, recipe screen or
prioritized alarm screen.  Eight real-time monitors (RTMs) used to display information
retrieved from the PLC or industrial PC may be placed on each screen.  Recipe screens allow
the system to be re-configured “on-the-fly” without having to re-program the PLC or operator
interface.  Menus increase the system’s flexibility by allowing settings and parameters to be
grouped in an efficient manner so that they are more easily controlled by the operator.
Prioritized alarms and trigger points allow the system to alert the operator to problems
detected within the system or processes running outside normal parameters.

Software
Configuring a terminal’s operation is easy with the use of TCP’s “microGUS”, a Windows
based configuration software package.  Using microGUS, the system programmer configures
the operator interfaces in a “WYSIWYG” fashion eliminating the guesswork associated with
other DOS based products.  Once projects are created using microGUS, they may be saved to
disk, printed, or downloaded to the Micro Greyline operator interface.
It is also possible to load an ASCII Terminal Emulation into the Micro Greyline.  Printable
characters are displayed on the screen as they are received at the serial port. Non-printable
characters provide for tabs, carriage returns, etc. Key codes are sent out the port as the keys
are pressed. The keypads can be configured for function key mode or data entry mode.  See
the Appendix for ASCII Terminal Emulation programming and operation.
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Reliability
TCP’s exclusive “Secure-FLASH” technology ensures your application’s data integrity
regardless of the environment the terminal is placed in. Each key switch used on the 1024 and
1025 products is rated at a minimum of 1million operations and provides immediate positive
audible and tactile feedback to the operator.  The all steel enclosure protects the operator
interface from the harsh environments commonly found in the industrial control industry.

Operation
The following drawing shows the main features of the Micro Greyline operator interface.

1. Display
The 2x20 LCD or VFD display is used to convey information to the system operator.  The
PLC or industrial PC may request messages to be displayed, or the function keys may be
configured to display messages, recipes, or menus.
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2. Function Key LEDs
Each LED is independently configured for operation and may be controlled by the PLC or
industrial PC, or by the function key’s operation.  The LEDs may be used to display operating
modes or guide the user, indicate the state of coils within the PLC, or they may indicate the
state of a function key by remaining on or blinking when the function key has been activated.

3. Run LED
The RUN LED is the system “heartbeat” and blinks quickly once every 5 seconds to indicate
that the OI is alive and well.  It will beat rapidly or remain on solid when the OI experiences
trouble.

4. Numeric Keys
The numeric keys are used by the operator to input data that will be sent to the PLC or
industrial PC.  These keys become active once the operator enters the data entry mode by
pressing the “CLR” key when the cursor is located on an RTM.  During data entry, the
function keys are not needed, so they become the numbers 1 through 5 when pressed.  To
access the upper keys, press and hold the shift key and press the desired digit 6 through 0.
When data entry is complete, the operator presses the ENTER key and the OI returns to
control mode where the function keys become active again.

5. Arrow Keys
The arrow keys are used to navigate between RTMs and screens.  When a screen is displayed
that contains a real-time monitor, the cursor will appear on the first RTM (the upper-leftmost
RTM).  Pressing the right arrow key moves the cursor to the next RTM.  Once the cursor is
residing on the last RTM on the screen, pressing the right arrow key again causes the next
linked screen to be displayed.  Pressing the left key works in the opposite direction and when
the cursor resides on the first RTM, pressing the left arrow again results in changing to the
previously linked screen.  If the currently displayed screen is not linked, then the cursor will
“wrap” from the last RTM to the first RTM and vice versa.  In data entry mode, the alternate
functions “DELETE” and “+/-“ become active.  Delete is used to remove characters from the
data entry field when an incorrect digit has been entered.  The +/- key is used to change the
sign of the entered data.

6. Increment/Decrement Keys
A faster method of entering data or “jogging” a process is to simply press the increment or
decrement key.  When the cursor appears on an RTM, each press of the increment or
decrement keys will immediately add or subtract the pre-programmed amount from the current
entry.  This pre-programmed increment/decrement value is programmable per RTM.
In data entry mode, the alternate functions “SHIFT” and “ENTER” become active.  Shift is
used to gain access to the numeric digits 6 through 0, and ENTER is used to complete data
entry when editing an RTM.  ENTER may also be pressed when an alarm is displayed on the
screen to silence the alert tone.
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7. Clear Key
The clear key is used to place the OI in data entry mode.  Once the cursor has been placed on
an RTM, pressing the clear key causes the OI to enter data entry mode and enables the
numeric keys.  The operator enters a new value, and presses “ENTER” to send the data to the
PLC.  When an alarm is displayed, the clear key will acknowledge the alarm, removing it from
the OI’s display and clearing any alert in progress.

8. Function Keys
The function keys are used by the system operator to control the PLC and OI’s operation.
Each function key may be programmed independently.  Each key can function as a momentary
button where a coil within the PLC is activated when the key is pressed, and de-activated
when the key is released.  Or it can function as a toggle button where a coil within the PLC is
activated by the first press/release combination of the key, and de-activated by a second
press/release combination. Also, a key can trigger a screen within the OI system.

Multi-Purpose Keys
In order to save space and reduce the confusion associated with many keys, the 1024 and 1025
have keys that provide more than one function based on the situation the OI is in.  In the
“operating” mode, the OI’s keys act as F1, F2, F3, F4, CLR, INC, DEC, and ⇐  ⇒ .  This is
the mode the OI is normally in.  These keys allow you to maneuver through screens, set or
clear coils in the PLC, and quickly adjust RTMs.
The “numeric entry” mode changes the function of the keys whenever the operator presses the
CLR key to enter data into an RTM, when a menu screen is displayed, or when the OI is
requesting a password prior to displaying a screen.  When the OI is in the numeric entry mode,
the function keys and CLR key become number keys and the increment, decrement and arrow
keys become SHIFT, DEL, +/-, and ENTER.  Access to the numbers 1 through 5 is as simple
as pressing the appropriate key.  To enter a number from 6 through 0, simply press and hold
the SHIFT key, and press the appropriate key.  If you are editing an RTM value, pressing
ENTER will return the OI to operating mode.  If you are selecting a menu option, simply
pressing the key will cause the OI to take action and depending on the screen recalled from
memory, the OI will either revert back to operating mode, or will remain in numeric entry
mode (if another menu screen is called).
The DEL key will remove previously entered characters from the RTM field, and the +/- key
will change the sign of the entered data when allowed (only on signed decimal and long
RTMs).

OI to PLC Communications
For the OI to be an effective interface between a process (or machine) and a human, it must
constantly communicate with the device that is controlling the process, passing data to the
PLC and receiving data from it.  A specific language or “protocol” is used for the
communications between the two devices, and although the protocol specifies how data is
transmitted and received, additional resources within the PLC are required as well.  For
example, some logic may be required to trigger screens at the appropriate time.
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Installation

Panel Cutout/Mounting
Drill four 3/16” holes in the appropriate locations for the four mounting studs.  Use the
provided drawing in the Appendix A of this manual as a guide.
Cut straight lines between the holes to form an opening for the OI.
Carefully insert the OI from the front of the panel.
Use the provided 8/32 nuts to snug down the OI to the panel.  Be careful not to over tighten
the nuts as it may cause damage to the OI.

Power Supply Connections
The power supply used to power the Micro Greyline must provide between 10VDC and
30VDC, and must be capable of sustaining at least 2.5W.
Using the supplied power connector, connect +10VDC to +30VDC to the power connector.
Pin 1 is identified on the “plug” side of the connector and should have the positive terminal of
the power supply connected to it.  Connect the power supply return (negative lead) to pin 2.
The power input is reverse polarity protected so if the wiring is backwards, you won’t damage
the OI.
Power connector pin-out:

CAUTION It is extremely important that you do NOT connect the chassis ground of the
power supply or the OI to the power return (negative terminal) of the power
supply.  In some cases, power supplies have shunts to do this, if your power
supply has the shunt installed, you MUST remove it!
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Serial Port Connections
The Micro Greyline support RS232 operation and either 3 or 5-wire RS422/RS485 operation.
The following are the pin connections for the Micro Greyline DB9 female connector on the
rear of the unit:

  (female)

 

Pin Function Connect To Type
1 RXD+ TXD+ on PC/PLC RS422/485
2 TXD RXD on PC/PLC RS232
3 RXD TXD on PC/PLC RS232
4 TXD+ RXD+ on PC/PLC RS422/485
5 Sig Gnd Gnd on PC/PLC Either
6 RXD- TXD- on PC/PLC RS422/485
7 N/C
8 N/C
9 TXD- RXD- on PC/PLC RS422/485

Total Control provides power cables and communication cables for use on most supported
PLCs.  Please call us for assistance in ordering the appropriate cable for your use.
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Chassis Ground Connection
The chassis ground connection is a required safety connection.  It also provides a means for
ESD to return to ground without disturbing the electronics within the OI.  The panel the OI is
mounted in should be solidly grounded to an earth ground.  If the OI is mounted on a door, a
good solid ground braid must be connected between the panel door and the panel housing (an
engine grounding strap works well for this).  Don’t rely on the hinges for the chassis ground as
over time they will corrode and the earth connection will become higher impedance thereby
reducing the effectiveness of the earth connection.
Connect a heavy braid between one of the OI mounting studs and a good earth connection.  It
is best to use the same grounding strap mentioned above for connection to the OI stud.  This
will not only provide a chassis ground to the door of the enclosure, but will also provide a
chassis ground to the enclosure of the OI.  Be sure to use a star washer that will cut through
any paint on the enclosure and ensure a solid connection.  If you are unsure about the
connection, use an ohmmeter to check for resistance when the connection is made.

CAUTION You must NEVER return current on the chassis ground!  The chassis ground is
for safety only and must never carry current.  Doing so will cause damage to
sensitive electronics within your system.  Always use the power supply return
circuit to return current to the power supply when using switches, motors, etc.!  If
your system will run without the power supply return connected, you have a
potentially hazardous installation!

ρ  NOTE
Units are factory loaded with RS-232 ASCII Terminal software. Printable
characters are displayed on the screen as they are received at the RS-232 port.
Non-printable characters provide for tabs, carriage returns, tabs, etc. Key codes
are sent out the port as the keys are pressed. The keypads can be configured for
function key mode or data entry mode. See the Appendix for ASCII Terminal
Emulation.
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microGUS - Version 2.0

Introduction
Micro Greyline Universal Software – microGUS is a easy to use, WYSIWIG message and
configuration editor for all Micro Greyline Operator Interfaces (OI).  microGUS provides
many powerful programmable features which you would only expect to find in much more
expensive operator interfaces.  These features include alarm, menu and recipe screens, special
characters, message linking, real-time data display, programmable setpoints, and password
protection.  microGUS was designed so that as new features are added to future versions of
microGUS, you will not need to upgrade the Micro Greyline OI.  This is because microGUS
will automatically update the operating system (OS) in the Micro Greyline if it doesn’t match
the version of microGUS that is being used.

MicroGUS Version 2.0 – Versions 2.0 and higher now support the Micro Greyline 524 and
525 Message Displays.  These operator interfaces are designed as low cost solutions for
applications that only need to provide information to an operator.  Since these displays do not
have any function keys or status LEDs, some of the descriptions in this manual will not apply
to these models.  Therefore we will use icons to distinguish between features that are

available for the 1000 Series  Micro Greylines and features that are only available for the

500 Series  Micro Greylines.
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Installation
The following instructions will walk you through the installation process of microGUS.
Installation is easy as long as you follow the instructions in order.

Windows 3.1 or 3.11
MicroGUS will NOT operate in the Windows 3.1 or 3.11 environments.

Windows 95 & 98 & NT
1. Insert the first microGUS disk into either drive A: or B:
2. Using the mouse, click on the Start button at the bottom left of the screen.
3. Select Settings, Control Panel on the Start menu bar.
4. Double-click on the Add/Remove Programs icon.
5. Windows will automatically find the installation software for microGUS.
6. The installation process will begin.  Simply follow the instructions on your screen.
7. When the installation process finishes, remove the disk from the drive.
8. Start microGUS by clicking on the Start button, select Programs.  Under the microGUS
heading, select microGUS.
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microGUS - Main Screen

The Toolbar & Tool Tips
The toolbar appears just below the menus and contains a number of buttons that allow quick
access to the majority of the functions available in microGUS.  If you are unsure of a button’s
function, simply place the cursor over a button.  After a short period of time, a tool tip will
appear that will indicate the button’s function.  The tool tip will change descriptions as you
move it across buttons.  Once the cursor has moved completely off toolbar buttons, the tool tip
will disappear.

The Project Bar
The project bar appears just below the tool bar and indicates the currently selected OI model,
the currently selected PLC protocol, and the currently viewed screen number.  In addition to
the project bar, the main form has a title bar (at the very top of the form) that indicates the
name of the current project.



12 ••••  microGUS - Version 2.0 Micro Greyline 1000 Series

Screen Entry Box

The screen entry box is the part of microGUS you will become most familiar with as this is
where all of the screen text, RTMs, and symbols are entered.  The colors will change as you
select different models to more closely resemble the OI model you are configuring.  The
up/down arrows to the right of the screen number box allow you to change the current working
screen.  You may use the PgUp and PgDn keys to scroll through the list of screens as well.
The number that appears just above the screen entry box is the column identifier that indicates
what column the cursor is currently located on.  This comes in handy for aligning columns or
just simply formatting data on the screen in an organized fashion.

Toolbar Buttons
Starting a New Project

To start a new project, click on the New Project button.  A form will appear asking for
the OI Model and PLC type, (these will default to the last saved project).

Select the desired OI Model and PLC type and click OK.  Starting a new project will clear all
screens, real-time monitors and will reset all system parameters to their default values.
An alternate approach to using the toolbar for this function is to use the File menu, then select
New.
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Retrieving Projects from Disk
There are three ways of retrieving a project from disk; you can click on the Open Project

button , click on the File menu then select Open, or simply click on the File menu and
select the desired project.  Remember that the last four projects edited will appear in the File
menu.
Note:  microGUS comes with a sample project that can be downloaded into the Micro
Greyline.  This sample project does not require that the Micro Greyline be connected to a
PLC.  This sample project demonstrates many of the features of the Micro Greyline.

Saving Projects to Disk
Project data may be saved to disk for later editing or for backup purposes.  To save a project,

click the Save Project button.  When a new project is saved for the first time, you will
be prompted for a name to save the project under.  If the project you are working on already
has been saved, clicking on the save project button will save the project under the same name.
To save the same project under a new name, click on the File menu and select Save As.

Once a project has a name, its name will appear in the title bar of microGUS each time you
edit it.  Additionally, the last four projects edited will appear in the File menu for immediate
selection.

An alternate approach to using the toolbar for this function is to use the File menu, then select
Save or Save As.

Printing Projects

To send a project to your printer, click on the Print Project button.  A form will appear
that will give you the option of selecting the range of screens to be printed.
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Click OK to begin printing the project.  The project will be printed to the Windows default
printer, printing all screen information, real-time monitor information (including location on
the screen), recipes, etc.  If you wish to print to a printer other than the Windows default
printer, then click on the File menu and select Printer Setup.  This menu will allow you to
select a specific printer and to modify any of the corresponding properties if desired.

Cutting, Copying and Pasting Text
To cut or copy text from one screen to another, or from one part of a screen to another,

highlight the text using the mouse.  Click on the scissors button to Cut the selected range

or the two sheet icon  to Copy the selected range.  Cutting will remove the existing text
while copying will copy it.  Select the destination screen and position the cursor where you

want to paste the cut or copied text using the mouse.  Click on the clipboard button  to
Paste the text into the new location.  Note that real-time monitors may be copied in this
fashion as well.

An alternate approach to using the toolbar buttons is to select the appropriate function from
the Edit menu or to right-click on the screen entry box and select the appropriate function
from the “floating” menu.

Justifying Text on the Screen
Screen text and real-time monitors may be justified or centered on a line.  Place the cursor on
the desired line and click one of the justification buttons.  The buttons (from left to right) are

Left Justify , Center , and Right Justify .  Left or right justification will
position the text against the left or right screen edge.

Adding Real-Time Monitors to a Screen
Real-time monitors are placed on the screen by placing the cursor on the screen in the location

that you desire the RTM to start and then clicking on the Insert RTM button.  After the
parameters have been configured for the RTM, it will be represented on the screen starting at
the current cursor location, and will correctly reflect the width of the RTM.  You will be
informed of RTMs that are placed too closely to the right edges (based on the RTM width).
RTMs cannot overlap each other.

Existing RTMs may be edited by either double clicking on the RTM, or placing the cursor on
the RTM and clicking on the Insert RTM button on the toolbar.
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An alternate approach to using the toolbar button is to select Insert RTM from the Tools
menu or to right-click on the screen entry box and select Insert RTM from the “floating”
menu.
(See the section labeled “Real-Time Monitors” for details.)

Placing Symbols on the Screen
The displays used in the Micro Greyline can display more characters than you can type on a
keyboard.  Many of these symbols are useful for providing more information to the operator
when data is displayed (the degree symbol ° is a good example).  To place one or more
symbols on the screen, place the cursor at the desired location on the screen and click on the

Insert Symbol icon.  A table of symbols will appear.  Use the mouse to select as many
symbols as you want, each will be positioned at the next location on the screen.  Click Close
when you are finished.

       
Note:  Different sets of symbols are available for LCD and VFD models.

An alternate approach to using the toolbar button is to select Insert Symbol from the Tools
menu or to right-click on the screen entry box and select Insert Symbol from the “floating”
menu.

Clearing Screens

Clicking on the Clear Screen icon  will clear the current screens contents and all real-
time monitors that have been placed on that screen.

Note:  A “clear” or unused screen is different from a “blank” screen.  If the PLC attempts to
trigger a unused screen, an “Invalid Screen” message will flash on the Micro Greyline.  To
create a “blank” screen, simply type at least one space into the screen editor.
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Selecting a Screen
There are three ways of selecting a screen for editing.  You can “scroll” through the screens
one at a time using the up/down arrow buttons just to the right of the screen number box, or
the PgUp and PgDn keys on your PC’s numeric keypad may be used.  To advance to a screen
more quickly, you can click on the Goto Screen button on the toolbar or click on the screen

number box.  A form will appear showing you a chart of screen usage. The screen usage
chart was designed to quickly show you which screens are in use, and how they are configured
(i.e. message, menu, recipe, alarm, or unused).

Click on the box representing the screen that you want to view. After the desired screen
appears, you are free to edit it.
An alternate approach to using the toolbar buttons is to click on the View menu and select
Goto Screen.

OI Configuration
There are a number of items that are “system wide”, that is, they affect the operation of the OI
from a system standpoint.  These items are adjusted in the OI configuration form which is

displayed when you click on the OI Configuration button.  A form will appear with
many tabs on it, each of which contains information specific to a particular part of the system.
(See the section labeled “OI Configuration”.)
An alternate approach to using the toolbar buttons is to click on the View menu and select OI
Configuration.
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Downloading Projects to an OI
Once a project has been entered, connect the download cable between the PC and the OI, and
apply power to the OI.  If the Micro Greyline has never been programmed before, the OI will

display the message “Not Configured - Run microGUS.”  Click on the download button 
in microGUS and the following form will appear.

PC Serial Port – Select the correct serial port for the OI download.
Download Options – The choice for “Automatically update protocol and OS” will allow
microGUS to compare the protocol and OS versions that already exist in the Micro Greyline
to the versions that exist in the microGUS folder on the PC.  If there is a difference, the
correct version will download automatically.  This is the recommended setting.

When you have the correct settings, click Start.  The top of the “Status” box will say
“Establishing Communication Channel…”  If the OI has never been configured before, the
download will begin automatically.  The bar graph will show you the progress of the
download.  If the Micro Greyline has already been configured at least once, you will be
prompted to cycle power to the OI.
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microGUS will give you 60 seconds to remove and re-apply power to the Micro Greyline.
The download will commence within the first ten seconds of power up.

IMPORTANT
NOTE:

For Micro Greyline models 1024 and 1025 with firmware version 1.2 or
lower, you must also hold CLR and F1 when powering up the unit.

Previous Versions of microGUS – Previous versions of microGUS were used to configure
the 1024 and 1025 Micro Greylines only.  If you are still using an earlier version of
microGUS, you must force the OI into program mode by pressing and holding the CLR and F1
keys until the four LEDs flash.

Getting Help

If you run into any problems, you can view the online help by clicking on the help icon 
on any of the screens that it appears on.  Using help, you can search for any topic within
microGUS, or you may review help based on the contents menu.

OI Configuration
When you click on the OI Configuration button, a form will appear that has five tabs on it.
Each tab represents a group of related items that are adjustable on a system level.  These
things include PLC communication settings, function key and LED settings, screen trigger
settings, etc.  This section describes each tab and the functions that are included beneath it.
To view and edit parameters within any tab, simply click on the desired tab.
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  PLC Comm Tab

The PLC Comm tab is used to configure PLC communication information such as baud rate,
parity, etc. If the selected PLC has an address, source, destination, or password, the
appropriate boxes contain controls for setting each.  New projects will have default PLC
communication settings that are based on the typical settings for each type of PLC.  If you
make changes to any of these settings and then decide to revert back to the defaults, simply
click the Defaults button.  It is extremely important that these settings are correct, otherwise,
the OI will not be able to communicate with the PLC.  The default communication parameters
are those we have found that appear to be the default for the PLC, so you might want to start
with these.  Refer to your PLC user manual for specifics about the communications
parameters.
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 Keys & LEDs Tab

 

The Keys & LEDs tab is used to configure the operation of the function keys and the function
key LEDs.

Function Keys
Function keys are used by the system operator to either turn coils within the PLC on and off or
display screens.  Each function key’s function is individually programmable as follows:

Disabled - The function key does nothing when pressed.
Toggle - The function key sets a coil in the PLC when pressed, and clears the same coil when
the key is pressed again.
Momentary - The function key sets a coil in the PLC when the key is first depressed, and will
clear the PLC coil when the key is released.
Screen Display - When the function key is pressed, the programmed screen will be displayed.

In the example above, F1 is programmed as momentary, F2 is programmed as toggle, F3 is
programmed to display screen number 10, and F4 is disabled.  The operation is as follows:
F1: When F1 is pressed and held, the PLC coil is set and remains set until F1 is released.
Function keys programmed for momentary operation operate even when alarms are displayed.
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F2: Each time this key is pressed, the PLC coil is “toggled”. If the coil is set, pressing F2 will
clear it, if the coil is cleared, pressing F2 will set it.  Function keys programmed for toggle
operation operate even when alarms are displayed.

F3: Each time F3 is pressed, screen 10 will appear on the display, unless an alarm screen is
displayed on the screen.  When an unacknowledged alarm is displayed, all function keys
programmed to display screens are ignored.
F4: No action is taken when F4 is pressed.

To adjust the function of a key, simply select the desired operation from the Function combo
box next to the associated function key label.  A screen number may be entered into the
Screen entry box if the operation for the function key is “screen display”.
Only the momentary and toggle functions will change coils in the PLC.  In order to
accomplish this the Enable Key Mailbox checkbox should be checked.  Once the Key
Mailbox is enabled, you must select the first of a series of coils that will be used as follows:
Key Mailbox - Key coils are coils in the PLC that the OI sets and clears to tell the PLC that a
key has been pressed.  The key mailbox is the base address of the coils within the PLC.  In
addition, there are a few other functions that use the coils to communicate data with the PLC.
The following is a list of the key coils and auxiliary function coils, and a description of each:

Coil Address Function
Base F1
Base+1 F2
Base+2 F3
Base+3 F4
Base+8 Data Altered
Base+9 OI Reset
Base+10 Invalid Screen Requested
Base+11 OI Watchdog
Base+12 PLC Requests Startup Register Data

F1-F4 Key Coils: These coils are set or cleared immediately when a function key is pressed.
If the key is configured to operate as a momentary contact, the coil will be set when the key is
depressed, and cleared when the key is released.  Toggle button operation sets the coil when
the key is pressed/released, and clears the coil when the key is pressed/released again.
Data Altered Coil (Base+8): This coil informs the PLC that data within the PLC has changed
either through the use of the increment/decrement keys, or by the operator changing a value in
the data entry mode.  This feature allows the PLC to bypass large, redundant ladder rungs that
are used to re-configure the system when parameters are altered.
OI Reset Coil (Base+9): This coil is set by the OI when it comes out of reset due to a power
cycle.
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Invalid Screen Requested Coil (Base+10):  If the PLC requests a screen for display through
the Screen Trigger Mailbox that is invalid, the OI will indicate to the PLC that it has requested
an invalid screen by setting this bit.  The PLC should inform the system operator that this type
of error has occurred.
OI Watchdog Coil (Base+11): This coil is set by the OI every 10 seconds to tell the PLC that
the OI is still operating normally.  The PLC should monitor this bit and clear it each time it
sees it get set.
PLC Requests Startup Register Data (Base+12): - This coil is set by the PLC to tell the OI to
send down all of the startup register data. (See in the section labeled “Startup Reg Tab”.)
Each time the PLC resets or restores a set of parameters, it requests that the OI does so by
setting this coil.  The OI will clear the coil when all data has been transferred.

You can enable or disable the increment/decrement keys on this form as well.  By default, the
increment and decrement keys on the OI are enabled.  To disable them, click on the Disable
INC/DEC Keys checkbox.

Function Key LEDs
The function key LEDs may be individually controlled by either the PLC or the OI.  By
default, they are all controlled by the OI.  Also, each LED may be individually programmed to
operate in one of the following modes:  On/Off, Off/On, Blink/Off, or Off/Blink.
If the LEDs should be controlled by the PLC, then the Enable LED Mailbox checkbox
should be checked.  When the LED Mailbox is enabled, the individual control defaults to the
PLC.  A combination of PLC and OI control can be accomplished by clicking in the columns
of boxes next to the F1-F4 labels.  The box will highlight red to indicate which one has
control.
LED Mailbox - The coils within this mailbox are used to control the four function key LEDs
on the OI when they have been configured to be controlled by the PLC.  The LEDs will follow
the state of the coil.  For example, when the coil is set, the LED will be on, etc.  The coils
reside in the same order as the keys, that is, the base coil address represents F1’s LED, base+1
represents F2’s LED, etc.
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  Screen Triggers Tab

 

The Screen Triggers tab is where you define how the PLC will trigger screens on the OI.

  Screen Trigger Mailbox - The Screen Trigger Mailbox  is the primary method of
triggering screens on the OI. The OI repetitively checks the PLC register defined as the screen
trigger mailbox, and if the data within the mailbox has changed, it will change the screen
contents accordingly.

 Current Screen Mailbox - The Current Screen Mailbox an optional mailbox that is
used by the OI to tell the PLC which screen is currently displayed.  In cases where the
operator has selected screens using function keys or menus, the PLC loses track of the
information on the OI screen.  There are several advantages to keeping the PLC and OI in
“sync.”  One of which is changing the operation of the function keys within the PLC based on
the screen that is displayed.  microGUS allows the system programmer to set a “Screen
Group” number that can match the actual screen number, or multiple screens can have a
common group number.  Using a group number instead of the screen number reduces the
overhead the PLC has in determining which functions the keys should operate on.
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For example, suppose the system programmer wants the function keys to have five different
functions within the system, but there are 200 screens programmed into the OI.  For the PLC
to determine what function the keys should possess, it must perform a large number of
comparisons that use excess memory and increase scan time.  The system programmer could
organize the screens in such a fashion as to allow more simple comparisons, but this makes the
project management for the OI a mess.  A better approach is to use the screen group number to
place the number 1 to 5 (# of functions in our system) in the Current Screen Mailbox when a
screen is displayed.  In this case the PLC doesn’t have to care what the screen number is, and
doesn’t have to perform a large number of comparisons to alter the key functions.
The address of the Current Screen Mailbox is the address of the Screen Trigger Mailbox +1 if
the Enable Mailbox checkbox is checked.

  Conditional Trigger Points – Conditional Triggers Points are registers within
the PLC that the OI monitors for an “out-of-bounds” condition as determined by the preset
high and low limit values.  Once a violation occurs (the register within the PLC exceeds the
high limit, or drops below the low limit), the OI will display the programmed screen
associated with the violation.  One of the uses for conditional triggers is to monitor system
settings for illegal states.  Due to the nature of the OI/PLC relationship and the fact that the
OI may not have power when the PLC does, etc. it must be strongly stated that triggers are
not intended for monitoring safety points, or things that require fast response.  Items of this
nature MUST be monitored by the PLC!
Up to 16 conditional trigger points can be monitored.  When this form is displayed, you only
view one trigger point at a time.  The trigger point that you are viewing is displayed in the
Trigger Number field.  To view a different trigger point, adjust the trigger number.  On each
individual trigger point, enter the Register Type, Address and Format.  Note that you cannot
monitor coils.  Also, set the high and low limits and the respective screen numbers to be
displayed.  When you have configured a trigger point, click on the Trigger Enabled checkbox
to enable it.
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  System Tab

 

The System tab allows you to control special system level functions.

  System Settings - The VFD Brightness options will only be enabled if you are
configuring a 525 or 1025 Micro Greyline.

 Screen Saver – The screen saver feature is designed to extend the life of the vacuum
fluorescent displays (VFDs). The screen saver is very much like the screen savers used on
personal computers.  After a programmed period of inactivity, the current screen will be
removed, and the screen saver text message will be alternate scrolling across each line on the
display.  Any time the system operator presses a key, or the PLC requests a screen to be
displayed, the screen saver is de-activated and the timer is restarted.
To enable the screen saver, click on the Screen Saver Enable checkbox and enter text for the
screen saver in the text box.  Set the inactivity time by directly entering a value or using the
spin buttons to scroll to the desired value.  The inactivity time specifies the amount of time
after the last key was pressed or the screen was updated before initiating the screen saver.

 System Passwords – Up to four system passwords can be set that are used to gain
access to individually protected screens.  Any valid number up to five digits in length is
acceptable.  Alpha characters are not valid.  Each password provides a different level of
access.  A password of 0 disables that level.  (See the section labeled “Screen Configuration”
for details.)
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Startup Register Tab

The Startup Registers tab is used to configure a group of up to ten registers that can be
downloaded to the PLC whenever the PLC sets the “PLC Requests Startup Register Data” coil
in the Key Mailbox.  Up to ten registers can be configured with preset values.  The “PLC
Requests Startup Register Data” coil is reset by the OI when the data transfer is complete.
Click on the checkbox next to Enable Startup Presets in order to use the startup registers.
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Screen Configuration
Every screen created in microGUS can have unique settings for the screen type and attributes.
These options are defined on the microGUS main screen so that you can see the settings for
the current screen at a glance.  A definition of each is described below.

Screen Type Box

 Each screen programmed into the 1024 or 1025 OI may be configured to operate in one
of four modes: Message screen, Alarm screen, Recipe screen or Menu screen.

 All screens programmed into the 524 or 525 OI will only operate as Message screens.
The “radio” buttons in this box are used to select the screen type for the current screen.
Details for each screen type are described below.

  Message Screen - A message screen is used to convey information to the
operator.  This type of screen is displayed when a function key is pressed, or the PLC requests
it.  Real-Time Monitors (RTMs) may be displayed on a message screen, and message screens
may be linked together to form messages longer than a single screen.  Message screens may
also be called through menus.

 Alarm Screen - An alarm screen is called by the PLC and will sound an alarm based on
the alert type selected.  Alarms have 4 priorities and will override the display of any other type
of display (except another alarm screen of higher priority).  Once the alarm is sounding, the
operator may press the CLR (clear) key to silence a continuous alert while leaving the display
contents unaltered.  Pressing the CLR key again will acknowledge the alarm and will remove
it from the display, returning the screen that was displayed just prior to the alarm being called.
If an alarm screen is called by function keys, linking, menus or conditional trigger points, the
alarm screen will act only as a message screen and will not sound the alert.



28 ••••  microGUS - Version 2.0 Micro Greyline 1000 Series

When the Alarm Screen  type is selected, the Alarms box is enabled.

The “radio” buttons are used to select the priority level, where 1 is the highest priority and 4 is
the lowest priority.
There are 8 alert types selections for alarm screens:

5 Seconds (alarm sounds for 5 seconds and stops audible warning)
30 Seconds (alarm sounds for 30 seconds and stops audible warning)
60 Seconds (alarm sounds for 60 seconds and stops audible warning)
3 Beeps (alarm beeps 3 times and stops audible warning)
5 Beeps (alarm beeps 5 times and stops audible warning)
1 Hz continuous (alarm beeps once per second until CLR is pressed)
2 Hz continuous (alarm beeps twice per second until CLR is pressed)
Continuous (alarm sounds until CLR is pressed)

 Recipe Screen – Recipe screens can be used to load preset values into the machine
directly from the OI.
An examples of recipe use is a bagging machine that has many sizes of bags and materials
used for the bags.  Such re-configurable items could include bag length, imprint
enable/disable, item count, sealing temperature, sealing time, and etc.
Each recipe screen can have 8 programmed preset values which are not visible to the operator
when the OI is running.  (See the section called “Recipe Editing” for details.)

 Menu Screen - Menu screens can be used to navigate from the currently displayed
screen to one of nine destination screens.  The destination screens are selected by pressing the
appropriate numeric digit (1-9) on the Micro Greyline keypad.  The destination screens can be
of any type, including recipe screens and other menu screens.
An example  use would be a bagging machine that has nine different sizes of bags.  A menu
screen could be used to select one of nine different recipe screens containing the preset data
for that size bag.
If more than nine menu items are necessary, multiple menu screens can be linked together .
(See the section called “Menu Editing” for details.)
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Screen Attributes Box

Each screen has a unique set of attributes associated with it, they are: Screen Group, Startup
Screen, Timed Display, Link Screen, and Password Enabled.

 Screen Group - A screen group allows the OI to communicate the currently displayed
screen to the PLC.  The data entered in this box is sent to the PLC each time the current screen
is displayed on the OI. By default, the screen group is the same as the screen number. In many
applications, it is desirable to change the operation of the function keys based on the screen
displayed.  If multiple screens require the same set of functions, all of these screens can share
the same group number.  This should reduce the amount of logic the PLC has to use to
determine how to react to the function keys.
For example, suppose the system programmer wants the function keys to have five different
functions within the system, but there are 200 screens programmed into the OI.  For the PLC
to determine what function the keys should possess, it must perform a large number of
comparisons that use excess memory and increase scan time.  The system programmer could
organize the screens in such a fashion as to allow more simple comparisons, but this makes the
project management for the OI a mess.  A better approach is to use the screen group number to
place the number 1 to 5 (# of functions in the system) in the Current Screen Mailbox when a
screen is displayed.  In this case the PLC does not need to know what the screen number is,
and does not have to perform a large number of comparisons to alter the key functions.
Note:  Screen groups are not useful with models 524 and 525 since there is no manual way to
change screens.

  Start-up Screen - The start-up screen is the screen that is first displayed when
the OI powers up.  The start-up screen typically indicates the model of the machine the OI is
installed on, the company name, and possibly a revision of the device.  There may only be one
start-up screen, but any of the 200 screens may be programmed as the start-up screen.
When the OI powers up, the value of the start-up screen will be written to the “Screen Trigger
Mailbox” in the PLC.  If no start-up screen is defined, then the OI will display the screen
based on the current value of the “Screen Trigger Mailbox.”  Screen number one is the default
start-up screen.  When you check the box for a start-up screen, the start-up screen check box is
cleared on any other screens.
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  Timed Display –  The timed display attribute is used to set the amount of time in
seconds that the current screen will remain displayed before changing to the “link screen”
(described next).  The timed display attribute is only used if the box is checked.  The timed
display setting is ignored if the “link screen” attribute is not also checked.

  Link Screen – Each screen can be “linked” to any other screen.  When the link
screen box is checked, the value represents the number of the screen to which it will be linked.
There are two ways that link screens can be used.

A “chain” of messages can be created by using the link screen attribute in conjunction with the
timed display attribute.  For example, screens 10, 11, and 12 could be “chained” by checking
both the timed display and the link screen attributes of each screen.  The link to value for
screen 10 would be 11, the link to value for screen 11 would be 12, and the link to value for
screen 12 would be 10.  This would link the three screens together in a “circular” series.
Screens do not have to be linked in sequential order.

The second use utilizes the “navigation” keys (left/right arrows) on the 1024 and 1025 Micro
Greylines.   If screens are linked without the timed display attribute, the arrow keys are used to
manually switch from one screen to the next.  This allows the operator to navigate through
multiple screens of information at his or her own pace.
The link screen value is for the “forward” link when the right arrow is pressed.  The “reverse”
link for the left arrow is automatically defined.  That is, if screen 10 is linked to screen 11,
pressing the right arrow on screen 10 will cause screen 11 to appear.  While on screen 11,
pressing the left arrow will cause screen 10 to be re-displayed.
Note:  If multiple screens have the same destination screen for the link screen value, the
“reverse” link for that destination screen will always cause the highest numbered screen to be
displayed.  For example, if screens 10, 20, and 30 each have the link screen value set to 100,
then while screen 100 is being displayed, the left arrow will always cause screen 30 to be
displayed.

 Password Enabled - It is often desirable to password protect screens in the OI to hide
them from certain personnel.  Some examples include supervisory control and system
diagnostics.  A screen that is password protected will not be displayed until a password of
equal or higher level is entered by the system operator.  There are four levels of password
protection, level 1is the highest and will allow access to any screen in the OI, while level 4 is
the lowest and will only allow access to those screens that are not protected, or are protected
with level 4 passwords.
Message, menu, and alarm screens can be password protected.  Alarm screens cannot be
password protected

If a screen requiring a level 1 password is displayed, the OI will prompt for a password.  The
password can be any 5 digit number between 1 and 99999.
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If nothing is entered within about 10 seconds, the screen reverts back to the previously
displayed screen.
If an incorrect password is entered, the following message will appear.

If a screen requiring a level 1 password is displayed, only the level 1 password will allow
access to the screen. If a screen requiring a level 2 password is displayed, a level 1 or level 2
password will allow access to the screen, and so on.

To enable password protection for the currently displayed screen, click on the checkbox to
enable the password protection, and enter a password level in the text box either directly or
using the spin buttons.  The actual passwords are defined in the “OI Configuration” form,
under the “System” tab.

Memory Usage Box

The three bar graphs at the bottom of the microGUS main screen display the current memory
status.  Since there are limited resources within the OI, the possibility exists (although rare) for
you to use all of the available resource or “fill up” the OI.  You can configure 200 screens,
1200 RTMs, and 1000 strings in a single project.  Each of the bar graphs indicates what
percentage of each you have used.
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  Real-Time Monitors

The purpose of the operator interface is to provide an easy method of communication between
human and machine.  In order for this interface to be successful, the OI must display
information that is stored within the PLC’s registers when the value is actually present in the
PLC.  The ability to read the data and show it as quickly as it changes in the PLC is referred to
as “real-time” data retrieval.  We call objects that are placed on the screen to display internal
PLC registers “real-time monitors” (RTMs) because they “monitor” registers inside the PLC,
and display the data in “real-time”.
When an RTM is on the currently selected screen, the OI will continuously read the value of
the PLC register and display it on the OI’s screen.
When data is read from a PLC register, it may be displayed on the OI screen in many different
ways.  This allows a number to be displayed to the system operator in a format that is easily
read by a human.  An example would be to display the words “On” and “Off” instead of the
actual data, ‘1’ and ‘0’.
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The Real-Time Monitor Editor is where you can format the way information is displayed for
each RTM that is inserted into a screen.  When an RTM is placed on a screen, characters will
be placed on the screen editor to indicate how the RTM will appear once downloaded to the
Micro Greyline.  See the following examples.

  PLC Register

The following is a list describing each of the formats, and what formats may be applied to
coils (bits in the PLC that can only be in a ‘0’ or ‘1’ state) and registers (storage locations
capable of holding large numbers).  Note that the total number of character positions required
on the display is indicated in each of the following descriptions.  These are the maximum sizes
for each format, the actual number of character spaces used is adjustable (see Real-time
Monitors: Attributes).

PLC Register Type – The PLC Register Types vary from one model of PLC to the next.  In
general, this will define where in the PLC memory table to look for the data.  For example,
many PLCs have specific labels for integers, coils, timers, counters, etc.  This selection will
usually contain a list of these labels.

Address – This field is the address or location in the PLC memory table for the data that is to
be monitored.

Sub-Element – The sub-element field will only be active when the data format is set as
“binary coil” (described later).  This field is used to select a bit position within a register.
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Register Formats
Signed decimal - This format is used to display a number from -32768 to +32767.  This
format requires 5 character locations on the screen, plus 1 for the sign.  The system operator
may enter a number within the same range when this format is selected, unless otherwise
restricted by the system programmer.  When a signed decimal RTM is placed on the screen,
one register (16 bits) is read from the PLC and displayed.

Decimal - This format is used when there are no negative values to be displayed.  This format
displays numbers from 0 to 65535, and requires a maximum of five character positions on the
display.

Long - This format reads two registers (32 bits) from the PLC and displays them as a single
value in the range of -2147483648 to +2147483647.  This format is used when extremely
large numbers need to be displayed.  The maximum character positions required is eleven.

4 digit BCD - This format is used to display a number from 0 to 9999 in binary-coded decimal
(BCD) format.  This format requires a maximum of 4 character positions on the OI screen and
requires the OI to read a single 16 bit register from the PLC.

8 digit BCD - This format is identical to the 4 digit BCD format, but allows numbers in the
range 0 to 99999999 to be entered and displayed.  This format requires a maximum of 8
character positions on the OI’s screen.  When an RTM is displayed using this format, two
registers (32 bits) are read from the PLC and displayed as a single number.

4 digit Hex - This RTM format allows PLC registers to be display in hexadecimal format.  The
range for 4 digit hex numbers is 0 to $FFFF.  Note that when the system operator is entering
values from the keypad, there is no difference between 4 digit hex and 4 digit BCD.  The
letters A through F will only be displayed when the PLC register contains a value to has letters
contained within the hexadecimal representation.  The increment and decrement keys on the
OI allow the full range to be entered.  The 4 digit hex format will read a single 16 bit register
from the PLC.

8 digit Hex - Similar to the 4 digit hex format, the 8 digit hex format displays a pair of PLC
registers (32 bits) in hexadecimal format on the OI screen, representing a range from 0 to
$FFFFFFFF.

Binary Coil - For some applications, simply displaying the coil’s actual state is important.
This format requires only a single character on the display and is used for reporting the state
of the coil. A real-time monitor using this format will toggle between ‘0’ and ‘1’ when the
increment or decrement keys are pressed.
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NOTE: The signed decimal, decimal, and long RTM formats display the number in base 10
(what you’re used to counting in), while the 4/8 digit BCD and 4/8 digit HEX RTM formats
display the number in base 16.  This is important to remember as the data may not appear on
the screen as you might expect.

  RTM Attributes

Real-time monitor attributes are options that may be enabled to enhance the look or operation
of the data being displayed or entered.  The attributes are unique to each RTM.

The following is a list of the attributes that may be programmed for each RTM:

  Display Type – This allows one of three types of display formats.
Strings:  This setting will cause one of nine programmable text strings to be
displayed based on the value of the PLC register.  (See the section labeled  “Strings
and Bar Graphs”)
Bar Graph:  This setting will show a horizontal bar graph up to ten characters wide.
(See the section labeled  “Strings and Bar Graphs”)
Data:  This setting will show the numeric value of the PLC register based on the
format that was selected for that register.

  Left/Right Justification -  This attribute determines the positioning of data within
an RTM field.  The data may be left-justified (“12345    “) or right-justified (“    12345”).  In
either case, entered data will scroll into the field from the right until the enter key is pressed.

  RTM Width - The field width attribute allows the system programmer to specify
the number of character positions an RTM will occupy on the screen.  This attribute will
dictate the field width.  If a number after formatting with commas, decimal, etc. requires more
space than is allowed by this attribute, ‘#’ symbols will be displayed to indicate that the RTM
is out of bounds.  No more than the natural number of digits and formatting (commas,
decimal, etc.) may be programmed into the field width.  This attribute will restrict the number
of used screen positions to the number required.  For example, if a value will always fall
between 0 and 10, there is no reason for the RTM to occupy 5 character positions in the case
where decimal format is selected.



36 ••••  microGUS - Version 2.0 Micro Greyline 1000 Series

  Decimal Position - The system programmer is free to position a decimal point
anywhere in the RTM field.  This allows numbers to be shown to the system operator with
varying resolution (i.e. 30.250 inches, or .1250 meters, etc.).  When the system operator enters
data, the decimal point is automatically inserted.  When this attribute is selected, the field
width increases by 1 character position.

  Use Scaling – When this box is checked, the information that is displayed by the
RTM is first modified by the scaling formula.  Scaling cannot be used when the PLC register
format is “Binary Coil.”  (See the section labeled “Scaling”)

  Use Leading Zeros - This attribute allows the system programmer to select
whether or not leading zeros on a number are displayed or suppressed. In cases where multiple
registers are placed side-by-side on the display, it may be desirable to leave the leading zeros
so multiple RTMs appear as a single number.  Leading zeros cannot be used when the PLC
register format is “Signed Decimal”, “Long”, or “Binary Coil.”

  Use Commas - This allows the number displayed on the screen to have commas
inserted every three decimal locations.  Numbers that would normally be displayed as 6000, or
100000, will be displayed as 60,000 and 100,000 when comma insertion is selected.  Note that
enabling this attribute will increase the number of character positions required on the screen (1
for every 3 digits).  Commas cannot be used when the PLC register format is “Binary Coil.”

 Enable Data Entry - This attribute determines whether or not the system operator may
alter the contents of the RTM.  When data entry is not enabled, the cursor will not land on it
when the arrow keys are used to navigate the screen.  (See the section labeled “Data Entry”)

  Strings and Bar Graphs

Strings - The most powerful format available to the system programmer is the text string.
This format allows the system programmer to enter a table of text strings for each RTM that
are displayed based on the value of the PLC register.  The PLC register is used as an index
into the table of strings to determine which string to display. Up to 10 strings may be
programmed per RTM.

This RTM is represented on the screen as a series of “S’s”.
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A simple example would be to store the following strings (in order 0, 1, 2) into the RTM
table: “Slow”, “Medium”, “Fast”.  When the PLC register contained the number 0, “Slow” is
displayed.  Likewise, when the PLC register is 2 or 3, “Medium” or “Fast” is displayed.  If the
value of the PLC register is less than zero or greater than 9, then the RTM will be blank.
If data entry is enabled while the display type is “String”, the increment/decrement keys may
be used to “select” the string.  (See the section labeled “Data Entry.”)  The value of that string
will be written to the PLC.  This may be useful for selecting modes or like the example in the
figure above.  This works well for items that are easier to identify by a name rather than by a
number.
Strings may also be used in conjunction with scaling.  (See the section labeled “Scaling.”)
Consider the following example:
Let’s assume that a shaft will be rotating between zero and 600 RPM.  If you would prefer to
display the words “Slow” (0 – 199 RPM), “Medium” (200 – 399 RPM), “Fast” (400 – 599
RPM), and “Full Speed” (600 RPM), this can be accomplished with scaling as shown in the
figure below.
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Bar Graph  - Bar graphs are just a special type of string RTM.  Instead of showing labels, the
RTM will show block characters.

This RTM is represented on the screen as a series of “B’s”.

If data entry is enabled while the display type is “Bar Graph”, the increment/decrement keys
may be used to increase or decrease the value of the register that the RTM is monitoring.  (See
the section labeled “Data Entry.”)

Bar Graphs may also be used in conjunction with scaling.  (See the section labeled “Scaling.”)
Consider the following example:
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This example uses a bar graph RTM to monitor a PLC register that will range in value from 0
to 100.  The “Scaling” box will divide the value by 10 to convert the range (0 – 100) to the
range (0 – 10).  Then 1 is subtracted to offset the range to (-1 – 9).  Remember that just like
strings, when the value is outside the range (0 – 9), the RTM will be blank.  Therefore, when
the actual value of the PLC is zero, then the value for the RTM will be “-1” after scaling,
causing the RTM to blank.  In order for this to work properly, the PLC register format must be
“Signed Decimal.”  This example also uses the increment/decrement keys to ramp the bar
graph up and down by 10% per key press.  See the figure below.

 Data Entry

Data entry is used when dual purpose keys on the 1024 and 1025 Micro Greyline are used for
entering data to the PLC.  When a screen is displayed that contains one or more RTMs with
Data Entry enabled, a flashing cursor will appear at the right-most character of the first RTM.
The left/right arrow keys can be used to move the cursor from one RTM to the next.  Once an
RTM is selected by the cursor, the CLR key is used to put the keypad into the data entry
mode.  The RTM will blank allowing digits to be entered through the keypad.  Once a value is
typed on the screen, the Enter key will send the value to the PLC if it is between the low/high
entry limits.

Hide Data Entry Characters – Sometimes it is necessary to use RTMs to enter passwords into
the PLC.  Checking this box will hide the password as it is entered.  This attribute has two
effects on a RTM; when the RTM is displayed, asterisks ‘*’ are substituted for each digit
displayed.  When the system operator enters data, each entered digit is displayed as a ‘*’.

Low/High Entry Limits - Two attributes, low limit and high limit, are used to restrict the data
that a system operator may enter into the RTM.  These limits may not fall outside the natural
bounds of the format selected (i.e. you cannot set a low limit of -5 when decimal format is
selected, negative numbers are not allowed on decimal format).

Inc/Dec Value - This attribute allows the system programmer to set the increment/decrement
rate on each RTM.  This is the value that is either added or subtracted from the current RTM
value when the system operator presses either the increment or decrement keys on the OI.
Each RTM has programmable rates.  Note that when the system operator hits an entry limit
(either low or high), the offending increment or decrement key no longer has an effect on the
data.
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  Scaling

The settings within the scaling box are used to alter the “units” of the PLC register.  Data read
from machine can be converted into terms more useful to the operator.  For example, if a
machine is to cut a pipe into a 5 foot piece, it will need to be told how many turns of the wheel
will equal 5 feet of pipe. On the other hand, the operator may not know how many rotations it
takes to cut a length of pipe to five feet.  Linear scaling is used to convert the number of turns
of the wheel into 5 feet.

Linear scaling may be accomplished with the formula Y = MX + B, where Y is the converted
data (data shown to the operator), X is the original data stored in PLC, and the variables M
(scale factor) and B (offset) are used to convert the data from one form to another.

The variable M is used to convert the scale (or range) of the data.  The easiest method of
determining the value to be used in variable M is to figure the ratio of the two ranges.  For
example, suppose the PLC reads a temperature gauge that provides it with a count of 0 to 250
which is supposed to represent a temperature range of 0 to 50 degrees Celsius.  The range of 0
to 250 must be compressed into the range 0 to 50 (or compressed by 5x).  Using microGUS,
you can set values of M to be <1 or >1 which allows the scale to be compressed or expanded
(any M value less than 1 converts the range to a small range, and any value greater than 1
converts the range to a larger range).  microGUS allows fractions or whole numbers to be
entered for the M variable.  Fractions are entered as the fraction, while whole numbers are
entered as Number/1.  In the above example,  the M information would be entered as 1/5
because the information retrieved from the PLC is 5 times larger.

The variable B is used to adjust what is called the “offset”.  Offsets are involved in many
conversions and are used when the point of interest in one of the ranges does not fall onto the
same numeric position in the other range.  Consider our previous example.  Now assume that
the sensor still provides the PLC with a value from 0 to 250, but this range now represents -25
°C to +25°C.  We already learned how to use the variable M to convert the ranges, but we
need some way of taking into consideration that a reading of 0 on the sensor, is NOT 0°C.  We
do this by using the variable B.  M in this case is still 1/5 since the range we get from the PLC
is 5 times greater than the range we want to display on the OI, but without B, we get a range of
0 to 50 (as in our previous example).  Since we want the range to be shifted (or offset) down
by 25 degrees, we would set the value B to be -25.
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Now that we have seen how linear conversion works, let’s look at our example and see what
the OI really does with information received from the PLC and sent to the PLC.  Data read
from the PLC is converted by first dividing the number by 5, and subtracting 25.  This data is
displayed to the operator in degrees C.  When the operator enters data, she is entering the data
in degrees C so the OI performs the opposite conversion on the data before sending it to the
PLC, namely, adding 25 to the data entered, and multiplying by 5.

Since linear scaling is the process of converting one unit of measure to another, there will be
times when incrementing or decrementing a number by small values won’t appear to have any
effect.  The reason for this is that the value that is being added or subtracted gets lost in the
conversion.  This is not a problem in the OI, but rather a side effect of linear conversion.  To
compensate for this, the Micro Greyline will increment or decrement the register until a
change is noted, regardless of the increment/decrement size programmed into the RTM.

 Menu Editing

When a screen is configured as a menu screen, the Edit button becomes active allowing you to
click on it.  When you click on the Edit button, the above form appears.  Each item in a menu
can display a screen when the associated number key is pressed.  This form allows you to
enter the destination screen for each menu item.  Any menu item with a screen number of 0 is
disabled.  By linking screens and selectively enabling the menu items in this form for each
screen, you can provide more menu items than will fit on a single screen.  Enter the screen
number directly or use the spin buttons to set the screen number for each menu item.
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 Recipe Editing

 

When a screen is configured as a recipe screen, the Edit button becomes active.  When you
click on the Edit button, the above form appears.  Up to 8 recipe presets and the gate coil may
be entered on this form.  The gate coil is the last item downloaded to the PLC and is used as
the “go” flag to the PLC.  The OI will clear this coil, download the preset register information,
and finally set the gate coil.  The PLC should monitor this coil and when it gets set, the PLC
can use the downloaded data.  You must specify the register type, the address, format and
preset data for each recipe preset you wish to use.  Setting the format to “Not Used” disables
that particular recipe item.
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Problems

If you are experiencing any difficulties with microGUS or your Micro Greyline, please follow
these steps in determining the cause of your problem prior to calling us for help.

Problems with microGUS
If you are having difficulties downloading projects to your OI, make sure the COM port
selected in the OI Download form matches the physical connection on your PC.
Make sure you have the cable properly connected between the OI and PC.  Make sure the OI
is in download mode (press and hold the CLEAR key, and press F1 on power up if the unit’s
firmware is V1.2 or earlier) before attempting to download a project.

Problems with the Micro Greyline
Make sure all connections are solid and have been made correctly.
Make sure the settings for the baud rate, data bits, stop bits, and parity match those selected on
your PLC or industrial PC.
If the problem is in the PLC sending or receiving data from the OI, make sure all of the
addresses match those in the ladder logic of the PLC.  The Micro Greyline will show a
character in the lower right hand corner of the display for certain PLC communication errors.

W write error
R read error
I initialization error
A invalid PLC register address error

Reaching Us
You can reach us at any of the following:
web page: http://www.Total-Control.com
email: Bob_Honor@Total-Control.com
Address:Total Control Products

2001 N. Janice Ave.
Melrose Park, IL  60160

Telephone: (708) 345-5500
FAX: (708) 345-5670
Please have your serial number, model number and a detailed description of the problem ready
before you contact us.  This will help us to solve your problem.
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Glossary of Terms

Coil - This term is a PLC industry term and represents a single bit within the PLC.  A coil
only has two states, set and cleared.  There are typically three ways of referring to each of the
two states that a coil may have.  To indicate that a coil is activated, it may be said that a coil is
“on”, “1” or “set”.  To indicate that a coil is deactivated, it may be said that a coil is “off”, “0”
or “cleared”.

Key Coil - This term refers to a coil within the PLC that is used by the OI to tell the PLC the
state of keys on the OI.  Depending on how the function keys on the OI are configured, the key
coil will be written to by the OI when a key is pressed.

OI - Operator Interface.  The operator interface is the device that communicates with the PLC
to get real-time information from it and to send real time information to it from the user.  This
is the primary means of communication between the real-world and the PLC.

Register - This is the term used to refer to a variable within the PLC that the OI can read or
write when communicating with the PLC.  Whereas a coil can only be on or off, a register may
have a value put into it.  The largest value that may be put into a register within the PLC
depends on the PLC, but typically values from 0 to 65535 may be placed into registers.  One
important use for these registers is to retrieve information and display it on the OI’s screen.
We refer to registers used like this as “real-time monitors” (RTMs) because the OI
continuously reads this data from the PLC and displays the data in “real-time” (what I see is
what is in the register NOW).

Screen Trigger Mailbox - The Screen Trigger Mailbox is any register within the PLC that
has a special purpose; to allow the PLC to tell the OI what screen to display.  Each time the
PLC wants to display a screen, it places the screen number into the OI mailbox, it’s that
simple!

Current Screen Mailbox - The Current Screen Mailbox is a register used by the OI to tell the
PLC which screen or screen group number is currently being displayed.
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System Operator - This is the individual(s) that use the OI to communicate with the machine
or process being controlled by a PLC connected to the Micro Greyline.  System operators in
many cases will have no idea how the OI or PLC actually work, they simply need to know
how get a job done.

System Programmer - This is the person that actually uses the microGUS Windows software
to configure the Micro Greyline.  The system programmer determines the “look and feel” of
the entire system.
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Appendix A

Panel Cut-out Dimensions

3.5" (88.9mm)

5.
3"

 (1
34

.6
m

m
)

3/
16

 D
IA

M
ET

ER

.1
5"

.1
5"

5" 12
7m

m

C
U

TO
U

T



48 ••••  Appendix B Micro Greyline 1000 Series

Appendix B

Key Legend Insert for 1024 and 1025
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Appendix C

ASCII Terminal Emulation

Units are factory loaded with ASCII Terminal Emulation software. Once you download an
application to the operator interface using microGUS, the ASCII Terminal software is
overwritten.  The ASCII Terminal Emulation software can be re-loaded through a separate
download utility.
Operation - Printable characters are displayed on the screen as they are received at the serial
port.  Non-printable characters provide for tabs, carriage returns, etc.  Key codes are sent out
the port as the keys are pressed.  The keypads can be configured for function key mode or data
entry mode.  The serial port connection defaults to 9600 Baud, 8 data bits, 1 stop bit, and no
parity (9600,N,8,1).  The normal printable characters encoded as 32-126 are printed on the
screen as they are received from the serial port.  Additional printable characters beyond the
ASCII set are encoded in the number range of 128-255.  The non-printable control characters
provide for tabs, carriage returns, vertical tabs, horizontal tabs, bells, backspaces, etc.
Key codes are transmitted to the serial port as the keys are pressed. The keyboard has two
modes that can be set: data entry, and functional. When power is applied, the functional mode
is entered. The following ASCII character codes are sent:
F1 ‘A’
F2 ‘B’
F3 ‘C’
F4 ‘D’
CLR ‘X’
INC ‘+’
LEFT ‘<‘
RIGHT ‘>‘
DEC ‘-’
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If data entry mode is entered, the following ASCII character codes are sent:
0 ‘0’
1 ‘1’
2 ‘2’
3 ‘3’
4 ‘4’
5 ‘5’
6 ‘6’
7 ‘7’
8 ‘8’
9 ‘9’
DEL 127 (ASCII DEL)
+/- ‘!’
ENTER 10 (ASCII LF, or ‘\n’ in the C language)

To control features of the terminal beyond the displayable ASCII encoding, escape sequences
are used.  Escape sequences consist of the ASCII ESC character (27 decimal) plus 1 or more
of the following decimal character commands.  These sequences will not be printed; instead
they are interpreted as commands to the terminal.  Note: The characters after the ESC are
decimal, not ASCII.  (Ex.  To set the cursor at line 2 and character position 4, send: [ESC,
Ctrl-A, Ctrl-B, Ctrl-D])  Do not transmit the commas.
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ASCII Terminal Emulation Escape Sequences
ESC,1,x,y (ESC, Ctrl-A,x,y) Position the cursor at line x (1-2), character y (1-20)
ESC,2 (ESC, Ctrl-B) Clear the screen and position the cursor home (1,1)
ESC,3 (ESC, Ctrl-C) Turn off the F1 function LED
ESC,4 (ESC, Ctrl-D) Turn on the F1 function LED
ESC,5 (ESC, Ctrl-E) Blink the F1 function LED
ESC,6 (ESC, Ctrl-F) Turn off the F2 function LED
ESC,7 (ESC, Ctrl-G) Turn on the F2 function LED
ESC,8 (ESC, Ctrl-H) Blink the F2 function LED
ESC,9 (ESC, Ctrl-I) Turn off the F3 function LED
ESC,10 (ESC, Ctrl-J) Turn on the F3 function LED
ESC,11 (ESC, Ctrl-K) Blink the F3 function LED
ESC,12 (ESC, Ctrl-L) Turn off the F4 function LED
ESC,13 (ESC, Ctrl-M) Turn on the F4 function LED
ESC,14 (ESC, Ctrl-N) Blink the F4 function LED
ESC,15 (ESC, Ctrl-O) Disable the cursor
ESC,16 (ESC, Ctrl-P) Enable the cursor
ESC,17 (ESC, Ctrl-Q) Set keyboard to data entry mode (0-9,del,+/-,ENTER)
ESC,18 (ESC, Ctrl-R) Set keyboard to function key mode F1-F4, CLR,INC,<,>,DEC
ESC,19 (ESC, Ctrl-S) Set the Baud rate of the serial port to 600 BPS
ESC,20 (ESC, Ctrl-T) Set the Baud rate of the serial port to 1200 Baud
ESC,21 (ESC, Ctrl-U) Set the Baud rate of the serial port to 2400 Baud
ESC,22 (ESC, Ctrl-V) Set the Baud rate of the serial port to 4800 Baud
ESC,23 (ESC, Ctrl-W) Set the Baud rate of the serial port to 9600 Baud
ESC,24 (ESC, Ctrl-X) Set the Baud rate of the serial port to 19200 Baud
ESC,25 (ESC, Ctrl-Y) Set the Baud rate of the serial port to 28800 Baud
ESC,26 (ESC, Ctrl-Z) Set the Baud rate of the serial port to 38400 Baud
ESC,27 (ESC, ESC) Set the Baud rate of the serial port to 57600 Baud
ESC,28 (ESC, Ctrl-\) Set the Baud rate of the serial port to 115200 Baud
ESC,29 (ESC, Ctrl-]) Set the serial port parity mode to none
ESC,30 (ESC, Ctrl-^) Set the serial port parity mode to even
ESC,31 (ESC, Ctrl-_) Set the serial port parity mode to odd
ESC,32 (ESC, SP) Set the number of serial data bits to 8
ESC,33 (ESC, !) Set the number of serial data bits to 7
ESC,34 (ESC, “) Disable text auto-scroll
ESC,35 (ESC, #) Enable text auto-scroll
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Appendix D

ASCII Character Set and Control Codes
To use this chart, find the character you want, add the number at the top of its column to the
number at the left of its row.  For example, J is 40 + A = 4A (hex), 64 + 10 = 74 (decimal),
01000000 + 1010 = 01001010 (binary).

Bin 0000
0000

0001
0000

0010
0000

0011
0000

0100
0000

0101
0000

0110
0000

0111
0000

Dec 00 16 32 48 64 80 96 112
Hex 00 10 20 30 40 50 60 70

0000 0 0 Ctrl-@  NUL Ctrl-P  DLE Space 0 @ P ` p
0001 1 1 Ctrl-A   SOH Ctrl-Q   DC1 ! 1 A Q a q
0010 2 2 Ctrl-B   STX Ctrl-R   DC2 " 2 B R b r
0011 3 3 Ctrl-C   ETX Ctrl-S   DC3 # 3 C S c s
0100 4 4 Ctrl-D   EOT Ctrl-T   DC4 $ 4 D T d t
0101 5 5 Ctrl-E   ENQ Ctrl-U   NAK % 5 E U e u
0110 6 6 Ctrl-F   ACK Ctrl-V   SYN & 6 F V f v
0111 7 7 Ctrl-G   BEL Ctrl-W   ETB ' 7 G W g w
1000 8 8 Ctrl-H   BS Ctrl-X   CAN ( 8 H X h x
1001 9 9 Ctrl-I    HT Ctrl-Y   EM ) 9 I Y i y
1010 10 A Ctrl-J   LF Ctrl-Z   SUB * : J Z j z
1011 11 B Ctrl-K   VT Ctrl-[    ESC + ; K °C k ↑

1100 12 C Ctrl-L   FF Ctrl-\   FS , < L \ l ↓

1101 13 D Ctrl-M   CR Ctrl-]   GS - = M °F m ←

1110 14 E Ctrl-N   S0 Ctrl-^   RS . > N ° n →

1111 15 F Ctrl-O   S1 Ctrl-_   US / ? O _ o Del
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Index

A
alarm priority 37
alarm screen 24
alarms box 37
alert type 37
arrow keys 3
attributes 16
auxiliary function coils 6

B
bar graphs 37
base address 44

C
chassis ground 9
CLEAR 4
clear key 4
Clear Screen 34
Com Port Speed 30, 45
Commas 39
communication parameters 44
copied text 33
copy text 33

D
Data Altered 6
data entry mode 4
DEC 4
Decimal Position 39
decrement 3
DEL 4
DELETE 3
download button 35
download mode 4
download options 30, 45

E
ENTER 3

F
F1 key 4
function key LED 6, 12
function key LEDs 46
function keys 4, 46
Function keys 11

G
goto screen button 35

H
Hide Entry with Password

Characters 39

I
Inactive 11
INC 4
increment 3
Increment/Decrement 39
Insert Symbol 34
inserting symbols 40
Invalid Screen Requested 6

J
Justification 39
justified 34

K
Key coils 6
key mailbox 6

L
Leading Zeros 39
LED 2, 12
legend insert 3
linear conversion 39
linked screen 37
lower limits 39

M
mailbox 5
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memory status 37
Menu screen 24
message screen 23
Momentary 11

N
numeric keys 3

O
OI Architect 1, 29
OI Configuration 35
OI mailbox 5
OI Reset 6
OI Watchdog 6
online help 35

P
password protect 22
password protected 37
passwords 47
paste 33
PC communications 45
PLC mailbox 5
PLC Requests Startup Register Data

6
Print Project 33
printer setup 36
project bar 31
protocol 5

R
radio buttons 36
read protection 13
read-only 39
Real Time Monitor box 38
real-time 13
real-time monitors 13
Real-time monitors 34
recipe screen 24, 43
retrieving a project 32
RS232 8
RS422/RS485 8
RTM 13
RTM attributes 38
RTM Width 38
RUN LED 3

S
save a file 36
save project button 33
scissors button 33
screen display 11
screen entry box 32
screen group 5, 20, 37
Screen linking 19
screen numbers 36
screen save 21
screen saver 47
screen type 36
screen utilization 36, 41
scroll 35
SHIFT 3
Starting a new project 32
Startup register settings 26
Startup Registers 49
startup screen 37
start-up screen 23
strings 39
strings box 39
symbols 26, 34

T
timed display 37
Timed message display 25
Toggle 11
tool tip 31
toolbar 31
trigger number 48
trigger points 48
Triggers 27

U
upload options 45

V
VFD brightness 47
VFD display 2, 47


